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PREFACE 

ABOUT THIS USER GUIDE 

This guide: 

 Describes the main features offered by Integration Objects’ OPC Client for MQTT, 

 Lists the system requirements for installing and running OPC Client for MQTT, 

 Explains how to configure OPC Client for MQTT, 

 And details how to use and run this OPC Client. 
 

TARGET AUDIENCE 

This user guide is intended for users who are looking for applications that can collect real-time 
data and publish those data into MQTT Brokers.  
Knowledge of the basics of OPC Data Access (OPC DA) specification is a prerequisite. It also 
assumed minimum knowledge of the MQTT protocol. 

 

DOCUMENT CONVENTIONS 

Convention Description 

Monospaced type Indicates a file reference 

Bold Click/selection action required 

 

Information to be noted 
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mailto:customerservice@integrationobjects.com
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INTRODUCTION 

1. Overview 

The Internet of Things (IoT) is a network of computing devices, intelligent systems, advanced 

analytics, mechanical and digital machines and/or objects that collect, share and transfer data 

without requiring human-to-human or human-to-computer interaction. The collected data can be, 

for example, sent to Cloud-based services for further analysis and reporting purposes.  

 

The application of IoT to the manufacturing industry is called Industrial Internet of Things (IIoT). 

IIoT can improve connectivity, efficiency, scalability, time savings, and cost savings for 

manufacturing organizations. IIoT empower industrial organizations to connect data silos with all 

of their people, and processes from the plant floor to the executive offices.  

 

The Message Queueing Telemetry Transport (MQTT) protocol is quickly emerging as the standard 

for IIoT, due to its lightweight overhead, publish/subscribe model, and bidirectional capabilities.  

As OPC is a powerful solution for communication in the industrial field, nowadays, the link between 

OPC and IoT protocols seems necessary to enhance performance, security, and operations 

automation and ensure high availability. 

 

Integration Objects’ OPC Client for MQTT leverages both MQTT protocol and OPC standard in 

order to allow you to collect real-time data from one or more OPC Data Access (OPC DA) servers 

and transfer those data to any MQTT Broker accessible through the network. This OPC client 

provides multithreading capabilities using MQTT Agents. 

 

2. Architecture 

The following diagram illustrates the OPC Client for MQTT typical system architecture.  
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Figure 1: OPC Client for MQTT Architecture 

3. Features 

The OPC Client for MQTT offers the following features: 

 A fully compliant OPC DA Client 

 An intuitive Graphical User Interface allowing users to easily and quickly configure 

multiple MQTT agents 

 Automatic discovery of all OPC Servers available on the network 

 Managing multiple local and remote connections to OPC Servers simultaneously  

 Monitoring data changes in real-time 

 Collecting and publishing real-time data into MQTT Brokers securely 

 Support of the following OPC Data Access functionalities: 

 Items browsing 

 Managing OPC DA groups (Add, Remove) 

 Performing synchronous and asynchronous read and write operations of item data 

values, their timestamps, and their qualities  

 Automatic reconnection to MQTT Brokers when the connection is lost 

 Support of MQTT protocol versions 3.1 and 3.1.1 

 Management of dynamic XML files to save the configuration settings for a user session 

 Data recovery options to resend data when the connection with the MQTT Broker is 

lost 

 Automatic reconnection to the OPC Server when the connection is lost 

 Windows Service Publisher: The publishing operations are managed by a Windows 

service working in the background, guaranteeing a continuous process and automatic 

restart when the host machine is restarted.  

 Tracing of all OPC calls and data requests. 

 



                                      OPC Client for MQTT User Guide 

 

 

customerservice@integrationobjects.com          
13 

4. Operating Systems Compatibility 

OPC Client for MQTT supports the following operating systems: 

 Windows 7  

 Windows 8 

 Windows 8.1 

 Windows 10 

 Windows Server 2008 

 Windows Server 2008 R2 

 Windows Server 2012 

 Windows Server 2012 R2 

 Windows Server 2016 

5. OPC Compatibility 

 OPC Data Access 1.0a  

 OPC Data Access 2.00 

 OPC Data Access 2.05a  

 OPC Data Access 3.00 

6. Minimum Hardware Requirements 

The following are the minimum hardware requirements to run the OPC Client for MQTT: 

 

 

 

 

 

 

 

  

 Description 

Processor 1 GHz (higher recommended) 

RAM 1 GB (higher recommended) 

Disk Space 200 MB hard disk space for full installation 

Table 1: Minimum Hardware Requirements 
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GETTING STARTED 

 

1. Pre-Installation Considerations 

In order to properly run the OPC Client for MQTT, the following software components need to be 

installed on the target system: 

 The OPC core components 3.00, which consist of all shared OPC modules including the 

DCOM proxy/stub libraries, the OPC Server Enumerator, .NET wrappers, etc.  

 .NET framework 4.5 or higher. 

 

Also, make sure there is no firewall or antivirus blocking the application. 

 

 

 

 

2. Installing and Running 

To install the OPC Client for MQTT: 

  
1. Run the Integration Objects’ OPC Client for MQTT installation package using an 

administrator account. The installation welcome dialog will appear.  
 

https://opcfoundation.org/developer-tools/developer-kits-classic/core-components
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Figure 2 : Installation Welcome Dialog 

 

 
2. Click the Next button. The license agreement will be displayed.  
 

 



                                      OPC Client for MQTT User Guide 

 

 

customerservice@integrationobjects.com          
16 

 

Figure 3: License Agreement Dialog 

 

 

3. After reading the license agreement, select the first option and click the Next button. By 
proceeding, you are accepting all of the license agreement terms. Otherwise, you can 
cancel the installation.  
The customer information dialog will appear.  
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Figure 4: Customer Information Dialog 

 

 

4. Add the user name and the company name and then click the Next button. The dialog for 

choosing the destination folder will be displayed.  
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Figure 5: Choose Destination Folder Dialog 

 

 

5. Click the Next button to use the default destination folder and continue the installation, or 
the Browse button to select a different destination folder. The installation dialog will then 
appear.  



                                      OPC Client for MQTT User Guide 

 

 

customerservice@integrationobjects.com          
19 

 

Figure 6: Installation Dialog 

 

 

6. Click the Install button to start installation.  
 
The setup will then copy the necessary files to the selected destination folder, create 
shortcut icons to launch the OPC Client for MQTT and authorization license program from 
the start menu and make an un-installation entry in the Control Panel  Programs  
Uninstall a program. 

 
7. Before the completion of the installation, the following dialog will be displayed in order 

to configure the user account that will be used to run the services: 
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Figure 7: Configure Service Account 

 

 

 
The selected user account must have the “Log on as a service” right granted and the 

account information must be correct for the service to run properly.  

If you do not enter a valid account, the Local System account will be used to run the 

services. You can still modify this configuration after the installation using the 

Windows services manager. 
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Figure 8: Installation Completed Dialog 

3. Files Included in the Distribution 

After running the setup, you will get the following main files on your system under the target 

installation folder: 

 

File Names Description 

OPCClientForMQTT.exe 
The graphical user interface 

OPCDAClientForMQTTService.exe OPC Client for MQTT service  

LicenseAuthorization.exe The license authorization tool 
allowing you to activate your 
licenses 

OPC Client MQTT Uninstaller.exe The Uninstaller 
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IntegrationObjects.OPCDAClientMQTTServ

ice.dll 

IntegrationObjects.OPCDAClientMQTT.Com

mon.dll 

IntegrationObjects.OPCDACLientMQTTDLL.

dll 

IntegrationObjects.OPCNetClientSDK.dll 

IntegrationObjects.Logger.SDK.dll 

IntegrationObjects.KNet.Forms.dll 

IntegrationObjects.KNet.Common.dll 

IntegrationObjects.KNet.Browser.dll 

IntegrationObjects.Logger.SDK.dll 

IntegrationObjects.Logger.SDK.UserCont

rol.dll 

DevComponents.DotNetBar2.dll 

IntegrationObjects.Networking.M2Mqtt.d

ll 

Newtonsoft.Json.DLL 

License.dll 

LaunchSetup.dll 

Core assembly files 

ConfigOPCClientSDK.ini 

OPCMQTTClientConfig.ini 

OPCDAClientMQTTServiceConfig.ini 

Configuration files 

OPC Client for MQTT User Guide.pdf This user guide 

OPC Client for MQTT Quick User 

Guide.pdf 
The quick user guide 

Table 2: Files in the Distribution 

4. Starting-up 

The OPC Client for MQTT user interface can be launched from the start menu shortcut.  
To do so, click on Start  Programs  Integration Objects  OPC Client for MQTT  OPC 
Client for MQTT 
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Figure 9: OPC Client for MQTT Start Menu 

 
The OPC Client for MQTT service is started automatically with the host machine restart. It can be 
started and stopped manually from the Windows services manager.  

 

5. Removing the OPC Client for MQTT  

To uninstall the OPC Client for MQTT, follow the steps below:  
 

1.  Click the Uninstall OPC Client for MQTT shortcut available in the start menu, as shown 
in the figure below: 
 

 

Figure 10: Uninstall Shortcut in the Start Menu 

 
The following dialog box will appear: 

 

 

 

Figure 11: Uninstall the OPC Client for MQTT 

 
2. Click the Yes button to start uninstalling. 
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3. The wizard will then take you through the removal steps. At the end, click Finish when the 
un-installation is complete.  

 
 

 

 

 
 
The OPC Client for MQTT can also be manually removed as follows:  

1. Go to the Control Panel.  

2. Click Programs and Features  

3. In the Programs and Features dialog screen, select Integration Objects’ OPC Client 
for MQTT.  

4. Click Uninstall then OK.  

The uninstaller program requires administrator right for the software removal to be 

completed correctly. 
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USING OPC CLIENT FOR MQTT 

In this section, you will find an overview of the OPC Client for MQTT user interface as well as the 

steps required to configure and use this software. 

1. User Interface Overview 

The OPC Client for MQTT user interface, illustrated in the figure below, allows you to connect to 

multiple OPC Servers and configure different MQTT agents. 

 

 

Figure 12: OPC Client for MQTT Main View 

 

There are four parts in the main user interface, as highlighted above: 

 Menu bar (1): It contains the File menu, the OPC Server menu, the MQTT Client menu and 

the Help menu. These menus provide access to the functions that help the user interact with 

the application. 

 Configuration tabs (2): This control contains 2 tabs, which are: 

o OPC Servers: Contains the list of connected OPC DA servers. 

o MQTT Clients: Contains the list of configured MQTT Agents. 

 Start page (3): This is the main welcome page. It allows users to quickly access the recently 

opened configuration files from the available, as illustrated below: 
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Figure 13: Start Page Menu 

 

From the same view, the user can also: 

o Create a new configuration by clicking on New Configuration button  

o Open saved configuration by clicking on Open Configuration button. 

 Log messages browser (4): This part displays log messages. The most recent messages are 

displayed at the top of the list. 

 

When launching the OPC Client for MQTT, a new empty configuration will be automatically 

created.  

 

2. File Menu 

 

Figure 14: File Menu 

2.1. Project 
Using the Project section in the File menu, you can:  

 New - Create a new configuration by hitting the New button. 
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 Open - Open an existing configuration by clicking Open and selecting the appropriate 

“.ocm” configuration file, 

 Save - Save your current configuration by clicking Save or Save As, 

 Exit - Close the application by clicking the Exit button. 

2.2. Settings 
Using the Settings section in the File menu, you can configure the OPC Client for MQTT settings. 

Click the Configure button to view and modify the OPC Client for MQTT settings. 

In the general settings tab, the user can: 

 Change the user interface theme.  

 Enable user authentication to access the configuration interface. 

 Choose to include the advanced settings into the MQTT Agents wizards. 

 Choose to automatically deny the stop services messages boxes when closing the user 

interface. 

 Configure the reconnection period to OPC DA Servers when the connection is lost. 

 

  

Figure 15: OPC Client for MQTT Settings 

You can configure the log parameters as illustrated in the following figure: 
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Figure 16: Log Settings 

 

 

 

 

 

2.3. Default Configuration 
The OPC Client for MQTT provides the possibility to set a saved configuration as a startup 

configuration. It means that the configuration will be loaded automatically at the application start-

up. To add a default configuration: 

 Save your configuration by clicking the Save button available in the File menu. Your 

configuration will be saved into a folder that contains the following files: 

o A file with the extension “.ocm” that contains the names of the DA configuration file. 

o Files with the extension “.xml” that contain the DA configuration 

 Then, click the Define button in the file menu. 

 

 

For more information about the above parameters, please see Table 7 Log Settings. 
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Figure 17: Define/Remove a Default Configuration 

 

 The open file dialog screen will be displayed. Select your saved OCM configuration and 

then click the OK button. 

 When you restart the OPC Client for MQTT, the default configuration will be automatically 

loaded.  

 

To remove the default configuration, click the Remove button.  

 

2.4. View 
Using the View Section in the file menu, you can check the OPC Client for MQTT Configuration 

tool activities by clicking on Log File button. 

 

Figure 18: View Log File 

 

3. Administrator Account  

3.1. Login into OPC Client for MQTT 
When starting the application, if the user had enabled the user authentication feature, the OPC 

Client for MQTT will ask the user for his login credentials.  
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Figure 19: Login Window 

 
The default admin credentials are:  

 Login: OCMAdmin 

 Password: OCM@2dmin 

 

3.2.  Edit Administrator Credentials  
To edit your login credentials (user name and password), click on the OPC Client for MQTT 
Configure button, click Edit Admin Credentials on the displayed window and the following 
window will be displayed:  
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Figure 20: Edit Admin Credentials 

It is highly recommended that users change the default password once they enable the user  
             authentication. 
 

4. OPC Server Menu 

In the menu bar of the OPC Client for MQTT, you can access the different OPC functionalities 

using the OPC Server menu: 

 

 

Figure 21: OPC Server Menu Bar 
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4.1. OPC Servers Management  
Click the Connect button in the OPC Server menu to connect to local and remote OPC DA 

servers. The connection dialog is shown in the figure below: 

 

 

Figure 22: OPC Server Connection Dialog 
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You can either browse the list of the OPC DA Servers available in your local machine or manually 

enter: 

 The Server name (ProgID) of your OPC DA Server, 

 The IP address or the host name of the machine that hosts this OPC Server. 
 

You can also refresh the list of available OPC Servers by clicking on the Refresh action available 

in the right click menu on the Local Host node. 

 

The Wait for server startup defines the time for which the OPC Client for MQTT will wait for the 

OPC Server to report that it is in the RUNNING state before declaring a connection error. By 

default, this field is set to 1 second (1000 milliseconds). 

 

The Reconnect after server shutdown option defines whether the OPC Client for MQTT should 

reconnect to the OPC Server after the shutdown request or not. 

 

After the OPC connection operation succeeds, a new node representing the new connection will 

be added to the OPC Servers tree view of the main user interface. 

 

 

Figure 23: OPC Servers Tree 

 

4.2. OPC Automatic Reconnection 
The OPC Client for MQTT monitors the status of the connected OPC Servers periodically. 

Whenever a communication problem occurs with any connected OPC Server, the OPC Client for 

MQTT automatically starts the OPC reconnection procedure. 

During the time interval in which the connection to the requested OPC Server is lost, the 

corresponding OPC items will be frozen in their latest status and the server node will be highlighted 

by a red icon and disabled. 
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Once the communication is reestablished and reconnection is successful, the OPC Server node 

will be enabled and you can resume using the OPC functionalities of the server. 

 

5. MQTT Client Menu 

In the menu bar of the OPC Client for MQTT, you can access the different MQTT functionalities 

using the MQTT Client menu: 

 

 

Figure 24: MQTT Client Menu Bar 

 
Using this menu, you can manage your MQTT Agents by adding a new one, remove a specific 

agent, remove all agents, view an MQTT agent properties, start or stop an agent and start or 

stop all agents. 

 

6. Help Menu 

You can access to the OPC Client for MQTT user guide or get information about the product 

version or build date using the Help menu. 

 

 

Figure 25: Help Menu Bar 
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OPC DA FUNCTIONALITIES 

When the user successfully connects to an OPC DA Server, a node will be created under the OPC 

DA Servers. We will explain in this section the main OPC DA functionalities available in the OPC 

Client for MQTT. 

1. OPC DA Server 

Right click on any added OPC DA Server node in the OPC DA Servers tree and the following 

menu will be displayed. 

 

 

Figure 26: The OPC DA Server Menu 

 

1.1. Add an OPC Group 
To add a new group to a connected OPC Server, right click on the server node and select 

Add Group from the displayed menu. The following dialog will appear: 
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Figure 27: Add Group Dialog 

 

General Properties 

 Group Name: The name must be unique among the other groups already created in the 
OPC Server. 

 Update Rate: specifies the fastest rate at which data changes for this group may be sent 
by the server. Passing 0 indicates that the server should use its fastest available update 
rate. The update rate is specified in milliseconds. 

 Dead Band: is the range through which the input may be varied without initiating a 
response. It specifies the change percentage in an item value that will cause a notification 
of this value to the OPC client. A 0.0 value indicates all changes to be received. 

 Time Bias: The purpose of the TimeBias is to indicate the time zone in which the data was 
collected. Enter 0 to use the default system TimeBias.  
 

Read Mode: indicates the read mode to be used for the group. There are three read modes: 
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 OnDataChange (for OPC DA version 2.05 and higher): the data will be collected 
asynchronously on report by exception basis. 

 Synchronous: the data will be collected by performing periodic synchronous read 
operations to a server. There are two types of read source: 

o DEVICE: Reading data from device. 
o CACHE: Reading data from cache. 

 Asynchronous (I/O 2.0): the data will be collected by performing periodic asynchronous 
read operations to an OPC DA version 2.0 or higher compliant server. 

 
Write Mode: indicates the write mode to be used for the group. There are 4 write modes: 

 Synchronous: allows the OPC client to send synchronous write requests to the OPC 
Server.  

 Asynchronous: allows the OPC client to send asynchronous write requests to the OPC 
Server (for OPC DA version 2.0 or higher). 

 Synchronous IO2: allows the OPC client to send synchronous write requests to the OPC 
Server (for OPC DA version 3.0). 

 Asynchronous IO3: allows the OPC client to send asynchronous write requests to the 
OPC Server (for OPC DA version 3.0). 

 Synchronous IO2 (WriteVQT): allows the OPC client to send synchronous write VQT 
requests to the OPC Server (for OPC DA version 3.0). 

 Asynchronous IO3 (WriteVQT): allows the OPC client to send asynchronous write VQT 
requests to the OPC Server (for OPC DA version 3.0). 

 

1.2. Browse an OPC Server  
You can browse the address space including all the branches and items for any OPC DA Server 

that supports OPC DA browsing. To browse your OPC Server, right click on your OPC Server 

node and choose Display Tag Browser from the displayed menu. 
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Figure 28: OPC Server Address Space Browser 

 

1.3. Remove an OPC Server 
To remove an OPC Server, click the Remove Server button available in the server right click 

menu. The OPC connection will be then released and the selected server node and its children 

nodes will be consequently removed from the tree view. 
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1.4. Remove All OPC Servers 
To remove all added OPC Servers, click the Remove All Servers button available in the OPC 

Server menu in the menu bar. All servers’ nodes will be deleted from the tree view and all OPC 

connections will be released. 

 

 

Figure 29: Remove All Button 

1.5. View OPC Server Status 
Select your OPC Server node and click on the Server Status button available in the server right 

click menu item. The following dialog will appear: 

 

 

Figure 30: Server Status Dialog  

 
This screen provides you with the current status and detailed information about the selected 

OPC Server. 
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2. OPC Group Management 

Right click on the selected OPC Group node and the following context menu will be displayed. 

 

  

Figure 31: OPC Group Menu 

 

2.1. Add OPC Items 
To add OPC items, click the Add Items context menu item. The Add Items window will be 
displayed as illustrated in the figure below. Then, drag and drop items from the items tree in the 
left side to the grid in the right side and click Apply.  
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Figure 32: Add Items Dialog 

 
To add all items, you can right click on the root node and press Add in the displayed menu, drag-
and-drop the root node to the grid view or select multiple tags using the mouse and the Shift key 
in your keyboard.  
To remove items from the selected list, you can select multiple items using the shift key in your 
keyboard and delete them using the Del button. 
 

2.2. Add Items Manually 
You can add OPC items manually by selecting Add Items Manually context menu item. The 

following window will be displayed. 
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Figure 33:  Add Items Manually 

 

In the Items section, enter the list of ItemID of the items to be added separated by the delimiter 

that you can select from the Delimiter drop down list then click the Apply button. 

2.3. Monitor OPC Items 
You can monitor OPC DA items values by selecting View Group Data context menu item. 
 

 

Figure 34: View Group Data 
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A new tab containing data changes grid view will be displayed in the main user interface, as 
illustrated in the figure below. 
 

 

Figure 35: OPC Data Changes Display 

 

2.4. Export Items to Data File  
You can export added tags into a csv file using the Export Items to Data File option. The file will 
contain all OPC tags with the following properties:  
Item ID, Item State and Item Data Type 
 

2.5. Import Items to Data File  
You can import a tags configuration file using the Import Items from Data File button available 
in the group right click context menu. The CSV file should have the following format:  
Item ID, Item State and Item Data Type. 
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Figure 36: Example of CSV File 

2.6. Change the Read Mode 
To change the read mode of the OPC group, click the Read Mode context menu item, you will 
have the list of available read mode as shown in the figure below.  

 

 

Figure 37: Change the OPC Group Read Mode 

For more information about the read modes, please refer to section “1.1 Add an OPC Group”. 

 

2.7. Change the Write Mode  
To change the current group write mode, click the Write Mode context menu item and select the 
new mode as shown below. 
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Figure 38: Change the OPC Group Write Mode 

For more information about the write modes, please refer to section “1.1 Add an OPC Group”. 

 

2.8. Set Group Properties  
To edit the properties of an OPC group, click the Group Properties context menu item. The 
following dialog screen will appear: 
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Figure 39: Set Group Properties Dialog 

 

Using this dialog, you can: 
 Change the name of the OPC Group. Note that the group name must be unique for each 

OPC Server.  

 Update the other group properties such as the update rate, the time bias and the dead 

band),  

 Activate/Deactivate the group state by checking/un-checking the Active State option. 

You can also use this screen dialog to view the current information related to the selected group. 
   

2.9. Remove All Items  
To delete all items of the group, select the related group node and click the Remove All Items 
context menu item. All added items will be removed from the tree view. 
 

2.10. Remove OPC Group 

You can delete an OPC group by clicking the Remove Group context menu item. The group node 
and all of its OPC items will be deleted from the tree view. 
 

2.11. View Group Properties 
In order to check the OPC DA Group properties, click on View Group Properties context menu 

item. The following dialog will appear: 
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Figure 40: View Group Properties Dialog 

 

3. OPC Item Management 

This section describes how to manage OPC items. It is assumed that at least one OPC item is 

added to an OPC group. 

Right click on the OPC item node and the following context menu will be displayed: 

 

 

Figure 41: OPC Item Context Menu 

 

3.1. Write Item Value 

To write a value to an OPC item, right click on the item and select the Write Item Value context 
menu item.  

 If the group write mode is Synchronous or Asynchronous, the following dialog 

screen will appear: 
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Figure 42: Write Item Dialog (1) 

 

This dialog displays the following information: 

 The OPC Server ProgID 

 The OPC Server Address 

 The OPC Group Name 

 The current Write mode set for the OPC Group. 

 The Item ID 

 The Item Data Type 

 The Item Current Value 

To complete the write operation, enter the new value to be written to the item and click the 
Apply button to confirm. 
 

 If the group write mode is SynchronousIO2 (WriteVQT) or Asynchronous IO3 

(WriteVQT), the following dialog screen will appear: 
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Figure 43: Write Item Dialog (2) 

 
To complete the write operation, enter the new value to be written to the item, optionally the new 
timestamp and quality. Then, click the Apply button to confirm. 

 

3.2. Remove an OPC Item 
You can remove an OPC Item by clicking on the Remove Item context menu item. The OPC 
Item will be removed from the tree view and from the data changes grid view. 
 

3.3. View Item Properties 
You can view the item properties by right clicking on the OPC Item and selecting View Item 

Properties 
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Figure 44: View Item Properties 

 

The following dialog will be prompted: 

 

  

Figure 45: Item Properties Dialog 

 

This dialog displays all of the tags information: 

 Item ID 

 Item Current Value 
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 Item Data Type 

 Item Quality 

 Item Time Stamp 

 Item Access Rights 

 Item Description 

 The OPC Server ProgID 

 The OPC Server Host IP 

 The OPC Group Name 

 The Item Active State 

 

You can update the Item Active State by checking or unchecking the Active checkbox and 
clicking the OK button.  
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MQTT FUNCTIONALITIES 

The MQTT Agent publishes data collected from any OPC DA server into MQTT brokers. In this 

chapter, we will describe the necessary steps to configure one or more MQTT agents. 

  

 

Figure 46: MQTT Client Menu 

 

1. Add New MQTT Agent 

To add a new MQTT agent, click the New Agent button located in the MQTT Client menu. The 

following wizard will be prompted:  
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Figure 47: Name and Protocol Version Configuration 

 
Step 1: Type the name of your MQTT Agent and choose the MQTT protocol version. Click the 

Next button. You will then be prompted to configure the Broker and connection parameters. 

 

 

 

 

 

The difference between the versions depends on the MQTT Broker and how it 

is implemented . 
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Figure 48: Broker and Publish Parameters Configuration 

 
The configuration parameters to be entered are detailed in the table below: 

 

Parameter Description 

Address The URL or the IP address of the MQTT Broker. 

Port MQTT Broker port 

Reconnection retry delay 
If the connection with the MQTT Broker goes down, the agent 
will try to reconnect to that broker every “reconnection retry 
delay” period. 

Keep Alive Period 
The longest possible period of time, which the Broker and the 
client can endure without sending a message. 
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Clean Session 
Check if the MQTT Broker should not store the session for the 
client ID. 

Topic Messages will be published to that Topic 

QoS The Quality of Service that will be used to publish data 

Retain 
If this option is checked, the last published message will be 
buffered in the Broker. 

Table 3: Broker and Publish Parameters 

 
Step 2: Type the MQTT Broker parameters. Click the Next button. You will then be prompted to 

assign OPC Groups to the MQTT Agent.  

 

 

Figure 49: Assign OPC Groups 
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Step 3: Click the Next button to display all new agent parameters as shown below: 

 
 

 

Figure 50: MQTT Agent Parameters Verification 
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Click Finish to confirm the new MQTT agent configuration, Back to edit your configuration or 

Cancel to exit the wizard.  

Once confirmed, the MQTT agent will be added to agents’ tree. 

 

 

Figure 51: Agents Tree 

 

2. Start Agent 

To start the MQTT agent, select the related node in the agents’ tree and click the Start button 

from the MQTT Client menu bar or right click on the agent node and select Start from the displayed 

menu. 

 

 

Figure 52: Start Agent 

 

3. Stop Agent 

To stop the Agent, click the Stop button in the MQTT Client menu bar or right click on the agent 

and select Stop from the displayed menu. 
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Figure 53: Stop Agent 

 

 

4. Remove Agent 

To remove an agent, select the agent node from the tree view of MQTT Agents and click the 

Remove button in the ribbon bar. 

 

You can also use the Remove Agent context menu item as illustrated in the figure below. 

 

 

Figure 54: Remove Agent 

Note that the MQTT agent should be stopped before being removed. 

 

 



                                      OPC Client for MQTT User Guide 

 

 

customerservice@integrationobjects.com          
59 

5. Remove All Groups 

To remove all groups that were assigned to the MQTT Agent, click the Remove All Groups button 

in the context menu bar. 

 

 

Figure 55: Remove All Groups 

Note that an MQTT agent should be stopped before deleting any group assigned to that MQTT 

agent. 

 

6. View Agent Properties 

To view the agent properties, click the View Agent Properties context menu item and the 

following window will appear:  

 

 

Figure 56: View Agent Properties 
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Figure 56: Agent Properties Window 

 

7.  Set Agent Properties 

To modify the MQTT Agent properties, click on Set Agent Properties context menu item: 
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Figure 57: Set Agent Properties 

 

8. Assign Group to Agent 

To assign one or more groups to an agent, click the Assign Group to Agent context menu item 

and the following window will appear:  

 

 

Figure 57: Assign Groups to Agent 

 

Select the groups that will be added to the MQTT agent and then click Apply. 
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9. Advanced Settings 

9.1. Authentication and TLS 
To configure the agent authentication and TLS, click the Advanced Settings  Authentication  

and TLS context menu button.  

 

Figure 58: Authentication and TLS 
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Figure 59: Authentication and TLS Configuration 

 

 
 

Parameter Description 

Use 
Authentication 

Check this option if you want to use authentication. 

Client ID 
The MQTT agent ID in the broker. Click “Generate” to generate 
a unique ID. 

Username Username to connect to the MQTT broker. 

Password Password to connect to the MQTT broker. 

Use TLS/SSL 
Check this option if you want to use a certificate for the 
communication with the MQTT broker. 

Protocol 
The protocol that will be used to secure the channel between 
MQTT Agent and MQTT Broker. It can be SSLv3, TLSv1.0, 
TLSv1.1 or TLSv1.2. 

Certificate Path 
The certificate file path. Click Browse button to choose the file 
location. 
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Table 4: Authentication and TLS Configuration Parameters 

 

Username and password are optional as the connection to some MQTT brokers does not 

require any username or password. 

 

9.2. Last and Will Testament 
To configure the agent Last and Will Testament Message, click the Advanced Settings  Last 

and Will Testament context menu button. 

 

 

                                           Figure 60: Last and Will Testament 
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Figure 61: Last and Will Testament Configuration 

 
The Last and will testament feature is used for notifying MQTT clients subscribed to the Will-Topic 
that the publisher client is disconnected abnormally (e.g. network communication problems). 

 

Parameter Description 

Use Last and Will 
Testament 

Check this option if you want to use Last and Will Testament 
message. 

Will-Topic The topic of the last and will testament publication. 

Will-Retain Check if the will-message should be retained. 

Will-QoS Sending will-message Quality of Service level. 

Will-Message 
The payload to be send to other clients in case of ungraceful 
disconnection. 

Table 5: Last and Will Testament Parameters 

9.3. Recovery Options 
To configure the agent recovery options, click the Advanced Settings  Recovery Options 

context menu button. These options allow to store the data to be sent to the agent locally during 
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communications disruptions and to be resent to the agent when communications are 

reestablished.  

 

 

Figure 62: Recovery Options 

 

Figure 63: Recovery Options Configuration 

 

Parameter Description 

Use Recovery 
Check this option if you want to use data recovery operation 
when the connection with the broker is lost. 
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In-Memory Check if you want to store data in-memory. 

JSON File Check this option if you want to store data in JSON files. 

Maximum File size 
The maximum JSON backup file size. If this limit is exceeded, 
a new file will be created. 

Delete files after 
recovery 

Check this option if you want to delete JSON backup files 
when the recovery procedure is completed. 

Table 6: Recovery Options Parameters 

10. Message Format 

The OPC Client for MQTT uses a JSON format to send data to the MQTT broker. This format has 

the following structure.  

 

Figure 64: JSON Message Format 
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 TRACING CAPABILITIES 

The OPC Client for MQTT has event tracing capabilities and produces 2 log files named as follows: 

 The LogEvent.log that records errors and debugging information generated by the user 

interface, 

 The MQTTServiceLog.log that records errors and debugging information generated by 

the OPC DA Client for MQTT service. 

If difficulties occur with the OPC Client for MQTT, the log files can be extremely valuable for 

troubleshooting. Under normal operation, the client logs contain very little information.  

These log files are generated at start-up under the installation folder. 

 

The OPC Client for MQTT incorporates 2 configuration files: OPCMQTTClientConfig.ini and 

OPCDAClientMQTTServiceConfig.ini. These files include several logging parameters. All 

these parameters have default settings and can be changed by editing the configuration files. 

 

To change one of the configuration files (in this example we use the 

OPCDAClientMQTTServiceConfig.ini file), you can proceed as follows: 

1. Open OPCDAClientMQTTServiceConfig.ini in a text editor. 

2. Edit any of the parameters listed in the following tables: 

 

Log Setting Description Default Value 

AutoAppend  
Set to true to continue writing log messages in 
the existed log file or to false to create a new 
file.  

True 

BufferSize 

The maximum number of messages to be 
stored in the runtime memory before launching 
a write action in the hard disk. The specified 
value must be greater than 100. 

100 messages 

FileName 
The OPC Client for MQTT Service log file 
name 

MQTTServiceLog 

MaximumFiles 
Set to 0 means that log files will be created in 
an unlimited way. 

0 

Level 

There are five log levels: 

1. Control: Logs only control messages 
generated by OPC Client for MQTT 
Service.  

2. Error: Logs error and control messages 
generated by the OPC Client for MQTT 
Service. 

Control 
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3. Warning: Logs warning, error and 
control messages generated by OPC 
Client for MQTT Service. 

4. Inform: Logs information, warning, error 
and control messages generated by the 
OPC Client for MQTT Service. 

5. Debug: Logs all messages generated 
by the Client for MQTT Service. 

The higher the log level, the more information 
is recorded. We recommend using level 
“Control” for a better performance of the 
service. The other levels are dedicated for 
troubleshooting purposes. 

AutoSaveTimeOut 
The time to wait to read all messages from the 
buffer and write it on hard disk, the minimum 
value is 10s. 

10 seconds 

Table 7: Log Settings 

3. Save the file for the log settings and restart your application for changes to take effect. 

Sample Configuration File: 

 

[FileLogConfiguration] 

AutoAppend=True 

BufferSize=100 

FileName=MQTTServiceLog 

MaximumFiles=0 

Level=Error 

AutoSaveTimeOut=10 
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TROUBLESHOOTING 

Case 1: Cannot launch the OPC Client for MQTT 
 
If you are using an evaluation license, you should first check the license validity by launching the 
License Authorization tool. You can start it directly from the startup menu: 
 

 

Figure 65: Open License Authorization Tool 

 

 
If the License Authorization tool shows that the demo has expired and you want to activate it using 
your full activation license, you should in this case follow the steps below: 
 

1. Run the License Authorization tool using an administrator account 
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Figure 66: Demo License Expired 

 

2. Click the Generate button 

3. Copy and send the User ID to the sales team {sales@integrationobjects.com} so they 

can generate your activation code. 

4. Enter the given Activation code 

mailto:sales@integrationobjects.com
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Figure 67: Activate License 

 
5. Click the Register button 

 
Case 2: Cannot start the OPC Client for MQTT service 
 
In case the OPC Client for MQTT DA service could not be started, check if: 

1. The license is still valid (see the first case above) 

2. The user has the privileges to run the service.  

In order to change the user account running the OPC Client for MQTT service, please proceed as 
follows: 

1. Open the windows service manager 

2. Right click on Integration Objects’ OPC DA Client for MQTT service and select 

Properties 
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3. Go to the Log on tab. 

4. Check This account and enter the user credentials for the service as illustrated in 

the figure below: 

 

 

Figure 68: OPC DA Client for MQTT Service Log on 

  

 

5. Click the OK button.  

To add the "Log on as a service" right to an account on your local computer 

1. Open the Local Security Policy 
2. In the console tree, double-click Local Policies, and then click User Rights Assignment. 
3. In the details panel, double-click Log on as a service. 
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Figure 69: Log on as a Service Policy 

4. Click Add User or Group, and then add the appropriate account to the list of accounts 
that possess the Log on as a service right. 

 
Case 3: Cannot connect to a local OPC Server 
 
You should check if the OPC Core Components are installed in your machine. You can find the 
OPC Core components under the following path: 
.:\Integration Objects\Integration Objects' OPC Client for MQTT\Components  
 
If they are already installed, you should use the regsvr32 command as shown below to register 
them again:  
 
1. Example (Windows 7, 64 bit, System Drive "C:"): 
 

regsvr32 C:\Windows\SysWOW64\opcproxy.dll 
regsvr32 C:\Windows\ SysWOW64\opccomn_ps.dll 
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Figure 70: Register OPC Core Components on Windows 7 64 bit 

 
2. Example (Windows 7, 32 bit, System Drive "C:"):  
 

regsvr32 "C:\WINDOWS\system32\opcproxy.dll" 
regsvr32 "C:\WINDOWS\system32\opccomn_ps.dll" 

 

 

Figure 71: Register OPC Core Components on Windows 7 32 bit 

 
You can also repair the installation OPC Core Components using the installation wizard. 
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In case the problem persists, you need to change the user account of the service to use an account 
that has access rights to connect your OPC Server and read data. Check Case 2. 
 
Case 4: I need to access the OPC Client for MQTT files. Where can I find the installation 
folder for OPC Client for MQTT? 
 
Follow these steps: 

1. Select the OPC Client for MQTT shortcut (from your Desktop or the Start Menu), 
2. Right-click on it and choose properties, 
3. A properties window appears containing the shortcut information, 
4. Click the Find Target … button. 

OR 
1. Open the OPC Client for MQTT 
2. Go to the File menu bar and click on Configure button 
3. Click the Installation Folder button as illustrated in the figure below: 

 

 

Figure 72: Open Installation Folder 

 
Case 5: Cannot connect to MQTT Broker 
If you configured a connection to an MQTT Broker and it does not work, check the following 

items: 

- The configured MQTT Broker address and port are correct, 
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- There is no proxy filtering or a firewall that blocks the communication with the MQTT 

Broker. You can check your connection with telnet: 

 

 

Figure 73: Check Port Availability using Telnet 

- The configured authentication parameters (Username, password) are correct. 

 

 

 

Case 6: Messages are lost 

We recommend you to configure Quality of Service parameters. More information are presented 

below: 

- Why is Quality of Service important? 

 QoS is a major feature of MQTT, it makes communication in unreliable networks 

a lot easier because the protocol handles retransmission and guarantees the 

delivery of the message, regardless how unreliable the underlying transport is. 

Whenever a packet gets lost on the way, the sender is responsible for resending 

the last message.  

- When using QoS 0? 

 You have a complete or almost stable connection between sender and receiver 

 You do not care if one or more messages are lost once in a while 

- When using QoS 1? 

 You need to get every message and your use case can handle duplicates. 

 You cannot bear the overhead of QoS 2. Because QoS 1 is a lot faster in delivering 

messages without the guarantee of level 2. 

- When using QoS 2? 

 It is critical to your application to receive all messages exactly once. 

 

 

 

 

 

 

 

 



                                      OPC Client for MQTT User Guide 

 

 

customerservice@integrationobjects.com          
78 

 

 

For additional information on this guide, questions or problems to report, please contact: 

 
Offices 
- Americas:    +1 713 609 9208 
- Europe-Africa-Middle East: +216 71 195 360 
 
Email 
- Support Services: customerservice@integrationobjects.com 
- Sales: sales@integrationobjects.com 

  
To find out how you can benefit from other Integration Objects products and custom-designed 
solutions, please visit our website www.integrationobjects.com. 
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